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ABSTRACT
Traction force microscopy (TFM) is a well-established technique traditionally used by biophysicists to 
quantify the forces adherent biological cells exert on their microenvironment. As image processing 
software becomes increasingly user-friendly, TFM is being adopted by broader audiences to quantify 
contractility of (myo)fibroblasts. While many technical reviews of TFM’s computational mechanics are 
available, this review focuses on practical experimental considerations for dermatology researchers new 
to cell mechanics and TFM who may wish to implement a higher throughput and less expensive 
alternative to collagen compaction assays. Here, we describe implementation of experimental methods, 
analysis using open source software, and troubleshooting of common issues to enable researchers to 
leverage TFM for their investigations into skin fibroblasts.

KEYWORDS: Mechanobiology, contractility, cross-correlation algorithms, smooth muscle actin

1. INTRODUCTION

Dermal cells generate traction forces on their surroundings to migrate, contract wounds, and 
maintain barrier function. Given the complexities of wound healing processes, functional assays to 
monitor these forces can be useful in preclinical development of new therapeutic strategies. Modulation 
of migration can accelerate wound healing, e.g. via epidermal growth factor (1), and cell migration relies 
heavily on mechanical forces (2). Mechanical force can also intensify scar formation (3), and small 
molecule modulation of cell contraction has reduced scarring in mouse models after incisions (4) and 
burns (5). Techniques to optically monitor cellular forces in vitro, collectively called traction force 
microscopy (TFM), are promising functional assays to investigate fundamental pathophysiology of 
dermatological disease and to support development and screening of potential therapies to modulate 
wound healing and scar formation via force generation. 

As an optical microscopy-based technique, TFM does not involve specialized metrology tools 
nor direct contact with cells, enabling inexpensive implementation and simple incorporation into most 
experimental workflows. In addition, TFM can be implemented using less expensive materials at lower 
quantities than those typically used for collagen-compaction-based assays of fibroblast contractility (6). 
Collagen-based assays also confound measures of contractility with matrix degradation, matrix 
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production, and cell-cell interactions (7), rendering TFM a valuable and potentially high-content 
complement to other cellular and molecular techniques.

Harris et al. first described wrinkling of thin silicone sheets as a method for estimating forces of 
adherent cells and are credited with launching the field of TFM (8). When cells were seeded onto 
compliant substrates, the traction forces they applied to the surface caused the substrate to “wrinkle”; 
this semi-quantitative Substrate Wrinkling Assay (SWA) is described in detail in Section 2. Briefly, 
microscope images of adherent cells under desired control and experimental conditions or as they are 
migrating capture the extent of substrate wrinkling (Figure 1). A highly cited early utilization of SWA 
correlated increased alpha-smooth muscle actin expression with increased fibroblast contractility (9), 
which now defines a commonly accepted feature of myofibroblast activation. Quantification of precise 
cell forces using this method is complex (10-12), so image processing routines to quantify apparent 
wrinkles as a proxy for force are often preferred.

More precise methods to quantify cellular contractile force were pioneered by Dembo and Wang 
(13), who added small markers to measure continuous deformations of thick substrates. These thick 
substrates have since become the standard for quantitative TFM (qTFM) as detailed in Section 3, and 
comparisons and considerations for using both SWA and qTFM are summarized in Table 1. In qTFM, 
cells are plated on compliant hydrogels that have small fiducial markers such as fluorescent beads 
embedded. Microscope images of the markers while cells are attached are compared to images of the 
markers once cells are released, and the force required to create the observed displacements can be 
calculated using equations from mechanics and knowledge of substrate stiffness. qTFM can also be used 
for multicellular analyses, though this approach is most common for monolayer-forming cells like 
keratinocytes, as evidenced by applications of qTFM to keratinocyte colony formation (14,15), 
cytoskeletal and junction protein assembly (16,17), and migration (18,19). Ladoux and Mege (2) provide 
an exceptional review of mechanics in collective migration with extensive discussion of wound healing 
and relevance to dermatology. 

For additional background reading on TFM broadly, we recommend exemplary reviews of its 
methods (20-22) and its computational algorithms (23-25). Techniques for three-dimensional TFM also 
have been developed (26-29), but we assume readers are interested in simple assays to complement their 
ongoing investigations so specialized 3D TFM is not discussed further. For discussion of methods to 
assess cell forces that require additional fabrication and metrology equipment, we direct the reader to 
excellent reviews of micropost arrays (30)(31), fluorescent stress tensors (32,33)-(24), and more (34). 

1.1. Applications Of TFM To Dermal Fibroblasts
Since the invention of TFM in the 1980s, SWA has been used extensively to observe dermal 

fibroblast contractility and, specifically, myofibroblast activation (9,11,35,36). Recently, to investigate 
processes that may be modulated to reduce scarring, SWA has been used to assess dermal fibroblast 
contractility as a feature of myofibroblast activation under hypoxic conditions (37), in co-culture with 
platelets (38), and in regenerative African Spiny Mouse cells (39). While SWA is typically used to 
examine heterogeneous populations of near-confluent cells, it can also be used on single cells plated at 
low density (11,35). Custom SWA substrates have also been used to improve the throughput of 
individual cell measurements to elucidate the role of individual genes in accelerated wound healing (40). 
Since multicellular monolayers are often used with SWA, this technique is compatible with subsequent 
collection of cells and lysate or fixation and imaging in situ after wrinkling images are acquired.

Leveraging qTFM as a single cell assay, groups have identified biophysical parameters that 
correlate with chronological age using normal human dermal fibroblasts (41) and myofibroblast 
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subpopulations with varying levels of contractility using fibroblasts from patients with Dupuytren’s 
disease (42). Researchers have also leveraged qTFM to investigate the role of calponin, an inhibitor of 
myosin ATPase, in non-muscle cell contractility (43), mechanisms of cobalt-induced fibrosis (44), and 
contractility of primary dermal fibroblasts from the regenerative African Spiny Mouse (39). 

Two-dimensional TFM holds broad appeal for dermatology researchers interested in 
characterizing fibroblast contractility, but implementation requires mastery of substrate fabrication and 
image analysis. In this review, we detail the two most straightforward approaches to TFM – semi-
quantitative SWA and qTFM – while focusing on practical experimental concerns for researchers new to 
the methods. Opportunities, challenges, and research questions well suited for these two methods are 
summarized in Table 1.

Table 1. Comparison of Common 2D Methods to Study Cell Contraction

Technique Opportunities Challenges Ideal Research Questions

Substrate 
Wrinkling 
Assay (SWA)

 Simple substrate fabrication 
compatible with standard tissue 
culture plates, flasks, and dishes

 Wrinkles can be detected with low 
magnification to accommodate 
heterogeneous populations

 Straight-forward image processing 
 Can be paired with broad range of 

additional assays

 Surface modification of 
silicone requires some 
optimization of non-standard 
culture methods 

 Quantitation by image 
processing alone does not 
resolve force

 Wrinkles are not stable under 
all fixation protocols

 Gain/loss of function, e.g., hypoxic 
conditions (37) or genetic manipulation (40)

 Rare or hard-to-obtain, e.g. patient-
derived, cells as easier technique likely to 
yield robust data with fewer attempts (39)

 Soluble factor effects, e.g. dose response 
curves, since multicellular data can be 
rapidly obtained without an automated stage

Quantitative 
Traction Force 
Microscopy 
(qTFM)

 Traction forces can be resolved for 
individual cells

 Cell-cell forces can be calculated 
among cell clusters and/or 
monolayers

 Single-cell analysis enables 
characterization of heterogeneity 
within cell populations

 Compatible with additional 
optical-microscopy-based assays

 Images must be paired; 
benefits from automated stage

 Image processing and force 
calculations require numerous 
steps; programming skills 
required to automate

 Chemical functionalization 
required to anchor gels to 
coverslips and protein coating 
to gels

 Cell-cell adhesive forces can be estimated 
from cell doublets or larger colonies (45,46), 
(47); cell adhesion can be controlled with 
patterns (48,49)

 Cell migration can be quantified by local 
force and displacement vectors  (41,50)

 Subcellular features can be quantified 
precisely; adhesive regions can be patterned 
to control cell shape and localization of 
adhesions (51)
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2. TECHNICAL DETAILS OF SUBSTRATE WRINKLING ASSAY

2.1. Overview of SWA Workflow
Compliant silicone substrates are crosslinked onto tissue culture plastic or glass for analysis of 

cell contractility. Substrate surfaces are functionalized with plasma or chemical treatments, sterilized 
with UV or ethanol, and matrix-coated in preparation for cell plating. Then, cells are seeded on the 
substrate and allowed to grow to the required confluency. Next, microscope images are taken of adhered 
cells under desired control and experimental conditions to capture substrate wrinkling (Figure 1). Images 
can be processed to quantitate the number and/or size of wrinkles.

2.2. Substrate preparation for SWA
Polydimethylsiloxane (PDMS), a type of silicone, is prevalent in microfluidic devices and 

commonly used as a soft substrate for cell culture. PDMS is prepared according to manufacturer’s 
instructions (e.g. Sylgard 527, Dow Corning) by combining two components in disposable cups with 
disposable mixing sticks for ease of cleaning. Viscous prepolymer solution will stick to mixing vessel, 
so it is recommended to mix ~30% more than the desired final volume. The silicone mixture can be 
poured into 6-well plates, petri dishes, or the bottom of flasks, desiccated under vacuum for 1 hour, and 
allowed to cure at 70°C overnight. Silicone substrates can be fabricated in a wide range of stiffnesses to 
mimic various tissues and pathologies by mixing silicones (52) or ready-to-use substrates purchased 
commercially, e.g. Excellness Biotech (Lausanne, Switzerland) and Advanced BioMatrix (San Diego, 
CA). Substrates with a modulus less than 10 kPa are recommended for basic SWA; stiffer substrates 
yield few wrinkles.

The high surface hydrophobicity of PDMS limits cells adhesion to bare PDMS, so surface 
treatment is recommended. Oxygen plasma (e.g. Harrick Plasma or ozone sterilization) and covalently 
bonded chemicals can improve cell attachment and spreading compared to unmodified PDMS (79), but 
chemical functionalization can be time-intensive and autofluorescence of chemicals can interfere with 
immunofluorescence microscopy. Coating with charged molecules like poly-lysine or proteins like 
collagen I can also enhance attachment, though the choice of matrix protein affects contractility (53).

2.3. Cell Culture and Image Acquisition
Cells are seeded on silicone substrates at the desired density. At confluency or other desired 

timepoint, phase-contrast images of the adhered cells are acquired for quantification of wrinkles. Since 
SWA images can be obtained at low magnification in standard culture plates, additional experimental 
factors can be assessed. For example, contractility can be quantified before and after being treated with 
Blebbistatin, a myosin inhibitor that induces cell relaxation as in Supplemental Figure I. Alternatively, 
after imaging, cells could be lysed for analysis or fixed for immunostaining.

2.4. Quantifying Wrinkles via Image Processing
Quantification of substrate wrinkling can be done by hand, semi-automated, or fully automated 

(see discussion in Supplemental Files). Briefly, ImageJ (NIH) can be used to trace each wrinkle and 
measure the traced area. Because this method is time-intensive, it is recommended only for small 
samples sizes or images with high background noise. Alternatively, users can set a threshold for each 
image and the resulting highlighted wrinkles are automatically calculated. This semi-automatic approach 
is useful for large data sets, though a blinded approach or analysis by duplicate researchers is 
recommended to mitigate bias. A fully automated macro for this process can be written in ImageJ or 
MATLAB (Mathworks), but it is difficult to set universal thresholding parameters. Human users can 
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compensate for noise from image to image, but setting an appropriate parameter in the code that 
automatically works for all images has proven difficult.

Figure 1. Simple procedures to assay contractility in dermal fibroblasts. In both assays, specialized culture substrates 
are prepared for cell plating. For the semi-quantitative substrate wrinkling assay (SWA), phase-contrast images of the 
plated cell monolayer can be processed to quantitate the number of “wrinkled” pixels. For quantitative TFM (qTFM), a 
substrate with fluorescent markers (e.g., beads) is fabricated and functionalized to support cell attachment. A phase or 
brightfield image of the cell is acquired to determine cell boundary, and then a fluorescence image of fiducial markers with 
the cell “attached” is acquired. Additional images can be acquired of live cells to monitor changing environmental 
conditions and/or migration. An “unattached”, a.k.a. “null”, fluorescence image of fiducial markers after removing the 
cell(s) is then acquired for post-processing to calculate traction forces. The resulting strain energy and/or a heat map of cell 
stresses are output by various algorithms. Additional details in text.

3. TECHNICAL DETAILS OF QUANTITATIVE TRACTION FORCE MICROSCOPY

3.1. Overview of qTFM Workflow  
Cell-induced deformations of hydrogels are quantified by processing images of fiducial markers, 

e.g., fluorescent beads, embedded in the gel. After fabrication, the substrate is characterized to determine 
mechanical properties and functionalized with chemicals and matrix proteins to ensure cell attachment. 
Next, microscope images are taken of the beads underneath cells in control and treatment conditions; 
afterward, cells are removed to capture the beads in an unstressed state for comparison (Figure 1). Some 
form of image registration using an automated stage, additional fiducial markers, and/or meticulous 
manual location-finding is necessary to compare reference and experimental images. After computing a 
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displacement field for the beads, cell traction forces can be quantified using continuum mechanics 
implemented through a variety of algorithms (24). 

3.2. Substrate Preparation for qTFM
3.2.1. Substrate Fabrication. The two most common materials used in qTFM are 

polyacrylamide (PAA), a polymer made out of repeating acrylamide subunits, and silicone, the same 
PDMS polymer used for SWA. PAA is readily available in most biomedical labs and is easier to 
decorate with fiducial markers than PDMS, so it is used more often for qTFM and will be discussed in 
detail here. PAA also affords negligible surface adsorption of serum proteins compared to PDMS but 
swells if not osmotically balanced. Mechanical properties of PAA (i.e. elastic moduli) can be tuned from 
~100 Pa to 100 kPa by adjusting the acrylamide monomer and bisacrylamide crosslinker ratio (54-61). 
For more detail, Tse and Engler have published step-by-step protocols for the fabrication of various 
PAA hydrogel formulations with their respective elastic moduli (61).

Since mechanical properties like elastic modulus are used during computational analysis to 
calculate forces or stresses (62,63), the PAA substrate must be well characterized. However, mechanical 
characterization of PAA gels can yield dramatically different values depending on the fabrication 
method, characterization method, age, and hydration of the gels (64). Researchers are encouraged to 
characterize under experimental conditions to ensure accurate values for analysis. If access to 
mechanical characterization equipment is limited, the reader is directed to Bashirzadeh et al. which 
details characterization using microscopy and inexpensive steel ball bearings (65).

3.2.2. Integrating Fluorescent Markers. Fiducial markers, typically fluorescent polystyrene 
beads with diameters 0.5-2 µm that can be imaged at 200-400x total magnification, are needed to track 
deformation of the substrate and quantify forces exerted by cells. Several methods have been developed 
to incorporate beads to the substrate, and the method used can greatly affect signal-to-noise ratio (SNR, 
see discussion in Supplemental Files). Emerging advanced manufacturing techniques enable 
sophisticated patterning of markers (39,40), but the simplest method to incorporate fiducial markers 
remains to mix the pre-polymer solution with fluorescent beads and polymerize the hydrogel following 
normal protocols. Alternatively, conjugation of functionalized beads to the top surface of the substrate 
can reduce background fluorescence from out-of-focus beads and increase the SNR (66). Matrigen, LLC 
(Brea, CA, USA) offers PAA substrates with embedded beads as a custom order. Alternatively, silicone 
substrates for quantifying single-cell contractions are available from Forcyte Biotechnologies Inc. (Los 
Angeles, CA, USA); their platform includes an ‘x’ shaped pattern (67) and the change in size of the ‘x’ 
can be used to estimate forces and bypass the computations described in section 3.4.

3.2.3. Functionalization and Protein Coating. PAA gels do not naturally facilitate the 
adsorption of protein; therefore, they must be functionalized to allow proteins to attach to the substrate 
and allow cell adhesion. The most widely-used chemical to functionalize PAA is N-sulfosuccinimidyl-6-
(4’-azido-2’-nitrophenylamino) hexanoate (sulfo-SANPAH) (61,68). A typical protocol is to pipette 
1mM of sulfo-SANPAH in 50 mM HEPES buffer (pH 8.5) over the PAA gel and then expose it to UV-
A light for 3 to 15 minutes. The sulfo-SANPAH is aspirated carefully by tilting the plate so as not to 
damage the gel, and the gels are rinsed at least thrice with a saline solution, typically PBS or HEPES. 
These steps may be repeated to facilitate better protein attachment. Functionalization will depend highly 
on peak wavelength emission of the UV chamber, distance between sample and UV source, and 
concentration of sulfo-SANPAH over the PAA gel. Note: Germicidal UV (as in a biosafety cabinet) is 
UV-C and will not work to activate sulfo-SANPAH, so a separate high-wattage UV-A source is needed. 
Alternatively, activation of PAA can be achieved by functionalizing acrylamide with reactive end-
groups before polymerization (69-71).
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After functionalization, matrix proteins can be pooled on the surface at concentrations between 
10-100 µg/ml for incubation times ranging from 30 mins at 37°C to overnight at 4°C. Generally, small 
volumes with high concentrations of protein are easier to keep localized on the gel surface. A reasonable 
initial protocol could utilize volumes and concentrations that yield ~40 ng/mm2 on the gel surface, 
assuming all protein came out of solution and attached, and to allow incubation for 2 hr at 37°C. 
Alternatively, microcontact printing (72) or microarrayed spots (73) can control shape and size of cell 
attachment regions. A simple way to test functionalization is by coating the activated hydrogel with an 
ECM protein conjugated with a fluorescent marker, e.g. inexpensive Protein A-FITC. Traditional 
immunostaining with antibodies can also test attachment and patterns (59). 

After functionalization and protein coating, moderate to high concentrations of suspended cells 
(e.g. 10,000 cells/cm2) are pooled on the gel in small volumes for a short period (10-20 mins) to 
facilitate attachment of cells to regions of interest. Additional media is added to dilute and clear cells 
that have not landed on areas of interest and to facilitate further attachment and spreading of remaining 
cells for hours or days, as desired. 

3.3. Image Acquisition and Pre-Processing
3.3.1. Acquisition Parameters and Maintaining Precise Focal Plane. Image acquisition of the 

fiducial markers and preparation of the images for analysis is a critical step in TFM, as any irregularities 
acquired will be amplified in subsequent processing which will limit interpretation of results. To get 
accurate displacement vectors from the bead displacement, sharp images of the fluorescent beads on the 
cell-substrate interface are required. Out-of-focus beads induce erroneous vectors that increase noise and 
can result in detection of strain energy that does not correspond to the force generation of the cell 
(Supplemental Figure IV). Flatness of the culture surface and subsequent focal plane of the beads is 
particularly susceptible to poor fabrication technique, details of which are discussed in Supplemental 
Files.

The focus of the image is affected by how much light is refracted when it passes through the 
media, the cell, the hydrogel construct, and the lens. It is therefore recommended to use clear hydrogels 
and limit the thickness of the substrate to <200 µm; however, thickness should be >>10 µm, so that cells 
cannot sense underlying rigid substrates (74). Ideally, each image taken will be manually focused at 
each time point; however, this is time-consuming and some motorized stages enable automation of 
image acquisition. Furthermore, changes in media levels (i.e. from removal, addition, or evaporation of 
media) and potentially temperature variations can result in small changes to the focal plane. Small drifts 
in z-plane focus can substantially affect the accuracy of subsequent algorithms. For our setup using <1 
µm-diameter beads and 200x magnification, we found a 13% error while 2 µm out-of-focus 
(Supplemental Figure IV). Strategies to reduce out-of-focus error and additional discussion of biological 
considerations for time-lapse experiments are included in Supplemental Files.

3.3.2. Stack Alignment. Stage drifting is common in motorized stages, especially when 
performing long time-lapse experiments, or when the plate must be removed from the stage, e.g. to add 
soluble factors. In addition to experimental controls, digital algorithms can improve alignment of a given 
set of images. For high-content experiments, i.e. >100 images, additional fabrication steps can support 
rapid stack alignment with a second reference layer of beads (15,75) or a regularized grid (76). The 
Template Matching ImageJ plugin at https://sites.google.com/site/qingzongtseng/template-matching-ij-
plugin rapidly aligns a stack of images using one of six matching algorithms; however, it requires the 
user to select a reference region with minimal deformation. Alternatively, Linear Stack Alignment with 
SIFT (included with ImageJ/Fiji at https://fiji.sc) does not require manual input from the user but takes 
longer (77).

Page 7 of 38

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60

https://sites.google.com/site/qingzongtseng/template-matching-ij-plugin
https://sites.google.com/site/qingzongtseng/template-matching-ij-plugin
https://fiji.sc


For Review Only

Experimental Dermatology – Methods Review Running Title: Quantifying Fibroblast Contractility

8

3.4. Displacement Quantification Using Cross-Correlation 
Before force calculations, qTFM requires calculation of displacement fields of the fluorescent 

beads (Figure 2A-C). This can be achieved by particle tracking, correlation-based tracking, or a hybrid 
of both techniques; see detailed comparison in Holenstein et al. (78). Correlation-based methods have 
short computational times and are widely available, so this section will review their practical 
implementation to quantify substrate displacements. Additional discussion and comprehensive details of 
correlation tracking algorithms can be found in Supplemental Files and Raffel et al. (79), respectively.

3.4.1. Software Package Selection. There are numerous cross-correlation algorithms and 
implementations available for particle tracking across an international community (see, for example, 
http://www.pivchallenge.org/). We recommend a user-friendly open-source platform developed by 
Thielicke and Stamhuis called PIVlab that works as a MATLAB (MathWorks) dependency (80,81). 
PIVlab simplifies the input of images and setting parameters to get the displacement of the fluorescent 
particles. Academic licenses for MATLAB are inexpensive and most universities (especially 
engineering departments) maintain site licenses; downloads and several tutorials for PIVlab can be 
found at http://pivlab.blogspot.com/. PIVlab allows two different correlation algorithms; the Fourier-
transform-based correlation (labeled “FFT”) is recommended as it can reduce computation time by 
~1000-fold. PIVlab also provides several pre-processing techniques for image enhancement to improve 
the quality of calculated displacements (Supplemental Files). In addition to digital enhancement, the 
region of interest (“ROI”) feature in PIVlab can be used to ignore debris or dark spots that would affect 
calculations.

Another user-friendly implementation is the ImageJ plugin PIV by Tseng found at 
https://sites.google.com/site/qingzongtseng/piv (82). The “iterative PIV(Cross-correlation)” menu option 
is recommended as a starting point as it requires the least user input. Thorough guidance on utilizing 
ImageJ for qTFM and optimizing parameters for each step of analysis have been compiled by Martiel et 
al. (83).

3.4.2. Interrogation Region Size. The interrogation region (IR) selected for the different passes 
of Fourier-based algorithms of PIVlab and PIV will impact vector resolution and SNR. IR defines the 
size (usually in pixels) of the region to be compared from frame to frame (79,81). The choice of IR is 
informed by the size, distribution, and concentration of fiducial markers as well as the magnification of 
image acquisition (Figure 2D,E). The length of the IR should be equal to 2n pixels, and this length 
should be greater than twice the marker displacements to avoid aliasing during Fourier-based 
computations. For example, if the maximum bead movement is 20 pixels, then the IR should be greater 
than 40 pixels. Bead size and distribution should be balanced with image magnification so that more 
than 5 beads are always in each IR to provide acceptable SNR (as determined by simulations; see Raffel 
et al. (79)).

Larger IRs for a set magnification and bead size will include more beads and thus better SNR; 
however, larger IRs decrease the spatial resolution of displacements and thus force vectors. Beginning 
analysis with an inappropriately small IR, i.e. a similar length to expected displacements, is also 
hazardous as beads may “disappear” between frames as they move to an adjacent IR and cause 
erroneous displacement vectors. Some algorithms, including PIVlab and PIV, enable multiple passes of 
successively smaller IR size to mitigate this conflict. Since each pass is fed information from previous 
passes, users can begin with a relatively large IR and still end up with good spatial resolution after 2-3 
passes. As an example from our previous work, PIVlab was used to generate displacement fields using 
two passes with an IR of 128 px and 64 px for the first and second pass, respectively, with a 50% step 
size at 200X magnification (image resolution of 0.16 µm/px with 0.52 µm diameter beads) (84). The 
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default settings in PIV, i.e. three passes with decreasing IR sizes of 128, 64, and 32 px, are reasonable 
for most single-cell images. However, if your magnification and density of beads suggest IRs > 32 px, 
you may choose to skip the third pass by setting the input value to “0”.

3.4.3. Post-Processing. PIVlab and PIV also include “vector validation” features to diminish 
erroneous vectors resulting from poorly distributed beads, under/overexposure, debris, and/or IRs on the 
image periphery. Empirically, in PIVlab, we found replacing vectors over 5 standard deviations from the 
mean with a vector average of adjacent IRs retains reasonable displacements while eliminating the most 
obvious erroneous vectors. PIV allows users to iteratively test two different post-processing methods, 
restore original results, or accept output and save. If numerous erroneous vectors are appearing at image 
edges, systematic cropping of stack-aligned images can reduce noise from peripheral regions. Cropping 
the image, for example, can help reduce noise from areas where no displacements should be detected. 
The exact dimensions of the cropped region could be adjusted to fulfill different cell morphologies, but 
multiples of IR edge length are recommended, i.e., length = A x 2n and width = B x 2n. 

Figure 2. Schematic illustrating 
critical dimensions for image 
acquisition and processing for single 
cell TFM. Phase-contrast image (A) of 
smooth muscle cell on 45 kPa 
polyacrylamide gel illustrates 
undeformed perimeter roughly half cell 
length to support single-cell analysis. 
Fluorescence image of bead layer (B) 
highlights features critical for 
correlation algorithms including (1) 
overall dimensions that are a multiple 
of the interrogation region (IR) 
dimensions, (2) IR dimensions which 
should be 2n pixels for subsequent 
Fourier-based analysis, (3) more than 
five particles per IR, and (4) particle 
displacements less than half the IR 
dimension. See Raffel et al. (79) for 
additional details.

3.5. Calculating Traction Forces, Stresses, and Energy
3.5.1. Primer on Mechanics Terminology and Units. After calculating displacements, vectors 

must be converted to forces. The simplest constitutive model relating displacement to force is Hooke’s 
Law, , where F = force (units: Newtons, N), k = spring stiffness (units: N/m), and x = 𝐹 = 𝑘𝑥
displacement (units: m). Using engineering stress and engineering strain, Hooke’s Law for linear elastic 
materials can be written as , where  = stress (force/area, units: Pascals, Pa = N/m2), E = Young’s 𝜎 = 𝐸𝜀
Modulus (units: Pa), and  = strain (change in length/original length, units: typically %).

Different algorithms quantify different measures of contractility, and distinguishing among them 
is important to compare across algorithms and experiments. Some approaches estimate force directly, 
while others calculate force distribution over an area (stress). Reported forces and stresses are often 
displayed as a heat map and statistics performed on maximum or average force or stress magnitude. 
Alternatively, statistics are performed on strain energy, which describes contractility as the total energy 
transferred from the cell to the substrate (units: Joules, J; see below). Therefore, care should be taken to 
report force, stress, and energy correctly according to algorithms employed.
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3.5.2. Calculating Contractility. There are numerous algorithms to calculate force, stress, 
and/or strain energy from bead displacement data; see technical discussion in Schwarz and Soiné (24). 
However, algorithms relying on the common assumption that bead deformations are small perform 
analogously (23), so we recommend Fourier Transform Traction Cytometry (FTTC) (50,60) because it 
does not require a cell outline and has the fastest processing time. The FTTC algorithm can be 
implemented in MATLAB to utilize displacements output by PIVlab or other cross-correlation 
applications. 

Alternatively, an ImageJ plugin that utilizes the FTTC algorithm to calculate cellular stresses is 
freely available at https://sites.google.com/site/qingzongtseng/tfm. Conveniently called FTTC, this 
plugin reads in the output of PIV and, together with user input, produces a visual display and text file of 
traction vectors. Likely because of historical quirks of vocabulary in the field, traction “forces” are 
output in units of stress (Pa). When using this program, we recommend either referring to output results 
(likely in kPa range) as “traction stresses” or converting to forces by multiplying by the IR area in µm2 
(likely yielding values in µN range) to avoid further confusion.

To generate a representative value to describe cell contractility that is useful for statistical 
analyses, strain energy, W, or the equivalent work that the cell had to perform to deform the substrate, 
can be calculated. Recommendations for implementing this calculation using ImageJ-based PIV and 
FTTC results are in the Supplemental Files.

4. SUMMARY

Functional assays of cell contractility remain critical to understanding skin remodeling, repair, 
and regeneration. TFM is a powerful functional assay to simply and inexpensively quantify fibroblast 
contractility and complement traditional cellular and molecular assays. Common sources of variability 
and suggestions for mitigating misleading analyses are summarized in Table 2. For researchers new to 
functional biophysical assays, SWA is recommended for its ease of fabrication and streamlined post-
processing. SWA has been widely used to investigate changes in contractility with environmental, 
genetic, and pharmacological variables. For single-cell investigations, qTFM has become preferred as it 
provides more precise subcellular information. With increasingly straightforward software and 
commercially available substrates, these TFM techniques can now be added to the toolbox of any 
laboratory for quantitative insight into cell contractility.

Table 2. Trouble-Shooting Traction Force Microscopy

Concern Mitigation Strategies

Poor cell 
attachment, 
cell death

Improve protein attachment: higher concentrations of functionalization chemicals and/or proteins; increased 
wash steps and/or wash times (SWA: §2.2, qTFM: §3.2.3)
Improve environmental control: increase temperature and/or time for protein and cell attachment; reduce 
exposure time/intensity of fluorescence exposure; adjust media formulation (Supplemental Files §B.2)

Suspicious 
wrinkle counts 
(SWA)

Improve signal-to-noise ratio: Reduce hydrogel stiffness (§2.2); crop images and/or use regions-of-interest to 
exclude errant regions
Leverage computational tools: Consider different analytical approaches (Supplemental Files §A); exclude 
wrinkles likely to represent noise (e.g. less than 4 px2 in area) and/or overexposed regions (e.g. greater than 
reasonable size determined by observation)

Randomly 
oriented 

Improve signal-to-noise ratio: optimize fabrication of gels to ensure level and well-distributed field of 
markers (Supplemental Files §B.1); enhance image focus (Supplemental Files §B.3); reduce hydrogel stiffness 
(§3.2.1); reduce size of IR (§3.4.2)
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displacement 
vectors
(qTFM)

Leverage computational tools: crop images and/or use regions-of-interest to exclude errant regions; pre-
process images (Supplemental Files §B.4); pre-align images before calculating displacements (§3.3.2); apply 
vector validation or ensemble average to smooth vectors (§3.4.3)

Suspicious 
force values 
(qTFM)

Check units: ensure displacements, forces (e.g. N), and stresses (e.g. Pa = N/m2) are all converted correctly 
from pixels with appropriate orders of magnitude (§3.5)
Improve cell health: see recommendations above
Inspect displacement data: poorly adhered cells, stiff substrates, and large interrogation regions (IRs) could 
lead to displacement quantification near the noise floor and subsequently lower-than-expected forces; 
randomly assigned vectors can result from regions that have no beads or beads that move out of frame can 
result in higher-than-expected forces, so ensure beads are well distributed (§3.2.2), consider increasing size of 
IR (§4.3.2), and/or implement vector validation (§3.4.3)
Reconsider microscopy parameters: increasing optical (not digital) magnification and/or improving 
resolution of acquired images will enable additional passes with smaller IRs and potentially better resolution 
of localized displacements and forces 

SWA = Substrate Wrinkling Assay; qTFM = Quantitative Traction Force Microscopy
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 Supplemental Files

A. Additional Discussion of Substrate Wrinkling Assay (SWA)

Many methods to quantify “wrinkles” of soft silicone substrates will successfully distinguish 
contractility of adherent cells. As described in the main text (Section 2.4), quantification of 
substrate wrinkling can be done by hand, semi-automated (manual thresholding), or fully 
automated. These example approaches and algorithms are compared in Supplemental Figure I 
and described in detail below.

Supplemental Figure I. 
Example phase contrast 
image (A) and wrinkle 
quantification by different 
methods. (B) Hand tracing 
method is slow (3-5 mins 
per image) but robust. (C) 
Manual thresholding 
method is quicker (~1 min 
per image), though it still 
requires interaction with 
each image. (D) Fully 
automated code is rapid 
(<1 sec per image) but 
conservative settings to 
reduce noise may also 
eliminate some of the 
signal. Note how some 
wrinkles appear divided or 
missing in inset. (E) All 
three analysis methods 
detect significant 
difference between 
treatments, but the ranges 
of resulting data vary.
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For this example experiment, tissue culture plastic was coated with Sylgard 527 (Dow Corning) 
per manufacturer’s instructions and cured at 70ºC overnight. The plate was plasma-treated for 25 
seconds (Harrick Plasma), sterilized under germicidal UV for 1 hour while covered in thin layer 
of PBS to maintain plasma activation, and coated with collagen I for 45 minutes at 37ºC. After 
rinsing the surface with sterile saline, passage 3 primary mouse dermal fibroblasts were seeded at 
a density of ~8,500 cells/cm2. Once seeded, the cells were allowed to grow to 80% confluency 
(36-48 hours) before analysis. Seven phase images across two wells were acquired for each 
condition. Then, the cells were treated with blebbistatin at a concentration of 2.92 µm/ml for 1 
hour. Phase images were then taken at the same relative spots as before for comparison.

A.1. Quantifying Wrinkles via ImageJ 
Detailed steps for quantifying wrinkles on soft silicone substrates using ImageJ 1.51 on a Mac:

1. Open desired image

2. Using “brush” tool to highlight each wrinkle by hand, zooming in as needed.
a. For semi-automation, skip this step.

3. Threshold the image by selecting Image > Adjust > Threshold
a. Before thresholding the image, if the image is not 8-bit, convert it by selecting 

Image > Type > 8-bit.

4. A “Threshold” window will pop up. Using the lower scroll bar, adjust the threshold value 
until only your wrinkles are visible against the red background (red indicates the area that 
will be set to black upon thresholding). For manual highlighting, your threshold value 
will be close to 255; for semi-automated, it will probably be between 100-200. Click 
“Apply.”

Supplemental Figure II. 

(a) Original Image (b) Red highlight while 
setting threshold (3)

(c) Result after 
thresholding (4)

(d) Result after 
converting to mask (5)

(e) [Left] Dialog window for “Analyze Particles” and 
[Right] “Bare Outlines” after analyzing particles (6). 

Note: 10 px was set as minimum size to reduce noise but 
can be adjusted.

(f) [Left] Dialog box for “Distribution” using 
wrinkle “Area” as an example and [Right] 

resulting histogram (7)
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5. Invert colors so that black wrinkles appear against a white background using Process > 
Binary > Convert to Mask.

6. Executing command Analyze > Analyze Particles will bring up a dialog with choices to 
filter based on particle size and circularity. To reduce noise, a minimum particle size can 
be set empirically.

a. If you have not used this command previously, Analyze > Set Measurements 
allows you to define measurements of interest. See details at ImageJ website: 
https://imagej.nih.gov/ij/docs/menus/analyze.html#set

7. From the “Results” window, you can run limited analysis within ImageJ.
a. Results > Distribution will bring up a dialog box for you to select parameter of 

interest and bins for a histogram.
b. Results > Summarize will add basic statistics to your Results window. Note: these 

statistics will be included in your “Distribution” if you run this step first.
c. You can also save to an Excel file: File > Save As.

B. Additional Discussion of Quantitative Traction Force Microscopy (qTFM)

B.1. Detailed options for integrating fluorescent markers
In general, a pre-polymer solution is mixed with the desired concentration of fluorescent 

beads (Figure III.1a) and then sandwiched between two flat surfaces (Figure III.1b). Once 
polymerized, the coverslip can be removed and the hydrogel functionalized or stored (Figure 
III.c). Note: We have found that level working surfaces are critical to obtaining a flat gel, which 
is crucial for obtaining in-focus images. Careful practice placing the coverslip flat and leveling 
all working surfaces helps to obtain a plane of in-focus beads. Take care when working on 
benchtops covered in absorptive material, and be sure to level surfaces and shelves in relevant 
equipment.

To reduce noise from out-of-plane beads, a smaller volume of hydrogel mixed with 
fluorescent beads can placed over a pre-polymerized bead-free hydrogel and covered with a 
coverslip to create a very thin uniform layer of beads close to the cell-substrate interface (Figure 
III.2b). In our hands, a concentration of 0.01% of 0.52 µm-diameter beads for the second step of 
the two-step process produced useful bead densities while limiting clustering. Alternatively, 
functionalized beads can be bound to the top surface of the functionalized gel without a second 
gel layer. (1)
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Supplemental Figure III. Methods to fabricate beaded hydrogels. The hydrogel-bead mixture method (1) 
involves full incorporation of beads into the gel solution. The two-step method (2) involves the polymerization 
of a “thin” hydrogel (<10 µm) with beads on top of a “thick” substrate (50-150 µm, typically the same hydrogel 
is used). Alternatively, hydrogels can be polymerized using a coverslip with an unpatterned (3) or patterned (4) 
bead distribution over the base hydrogel without the need of a second polymerization step.

Other methods for obtaining a planar bead layer include evaporating fluorescent beads 
onto a coverslip that will serve as the top part of the hydrogel (Figure III.3a). (2) The hydrogel is 
then sandwiched between the beaded coverslip and another flat surface (Figure III.3b). Once the 
beaded coverslip is removed, the beads transfer from the coverslip to the hydrogel (III.3c). 
Coverslip deposition also allows for patterned placement of markers. Printed patterns and soft 
lithography stamps or stencils can be used to pattern beads onto the coverslip (Figure III.4a), and 
once the coverslip is removed, the pattern is transferred to the hydrogel (Figure III.4bc). 
Patterned coverslips can also be used to transfer proteins. (3)

B.2. Biological Considerations of Time-Lapse Experiments
Traction forces may be monitored over extended periods for various applications, for 

instance, to quantify changes in response to soluble molecules, e.g. growth factors. In addition to 
maintaining the focal plane, another challenge of long time-lapse experiments include the cells 
experiencing frequent overexposure to fluorescent wavelengths. This comes from both the 
excitation wavelength necessary for imaging and the emission wavelength from the fluorescent 
markers. Exposure of media to fluorescence could also lead to free radical generation and 
increased toxicity. Therefore, light exposure to the cells and media should be minimized. Phenol-
red-free culture media, sodium bicarbonate supplement, HEPES buffer, and frequently changed 
or perfused media can reduce free radical damage and improve CO2 regulation. Also, pseudo-
randomization of the order in which you image samples helps to ensure you are not inadvertently 
capturing cell response to being on the microscope stage rather than your variables of interest.

B.3. Image Acquisition Parameters and Maintaining Precise Focal Plane
Small drifts in z-plane focus can substantially affect the accuracy of subsequent 

algorithms. For our setup using 0.52 µm-diameter beads imaged at 200x, we have found that a 
difference of 1, 2 and 3 µm out-of-focus can create a strain energy percent change of 0.5, 13, and 
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48%, respectively (Supplemental Figure IV). Strategies to reduce out-of-focus error include 
upgraded objectives with a small aperture and a large depth of field, implementation of a 
microscope autofocus system, increased contrast between the beads and the background, creation 
of a stack in the z-direction to select the best image for each data point, and utilization of larger 
beads.

Supplemental Figure IV. Visual and calculated strain energy with respect to changes in 
the focal layer. Fluorescent and phase-contrast images changes very little from 0 to 2 µm, 
but a significant visual difference is seen on focal plane differences greater than 4 µm. 
For 1, 2 and 3 µm out of focus, the strain energy (and percent change) increased from 
0.071 pJ to 0.072 pJ (0.5%), 0.090 pJ (12%) and 0.107 pJ (48%), respectively, while for 
changes greater than 4 µm the strain energy was greater than 0.150 pJ (106%). 

B.4. Pre-Processing in PIVlab
In addition to fabrication and experimental techniques to improve signal-to-noise ratio of 

acquired images, algorithms in PIVlab and other software can digitally enhance SNR. In PIVlab, 
contrast limited adaptive histogram equalization (CLAHE) increases readability of image by 
independently optimizing low and high intensity regions, which improves the detection of 
displacements.  A window size of 10 for the CLAHE filter worked well for our images acquired 
at 200x magnification (0.16 µm/px) with 0.52 µm beads (Supplemental Figure V). High pass 
filtering, another option in PIVlab, sharpens the image and improves SNR by emphasizing high 
frequency information and suppressing low frequency information. For our methods, a filter 
setting of 30 improved SNR and subsequent analyses. For consistency, the same pre-processing 
settings should be used for each data set, similar to fixing exposure intensity and times for 
fluorescence imaging.
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Supplemental Figure V. Effect of image pre-processing techniques in PIVlab. The original 
image taken at 200x total magnification can be seen after applying contrast limited adaptive 
histogram equalization (CLAHE), a high pass filter, and both (“All”) to the image. The 
resulting image has improved sharpness and less background noise, which is then used in 
cross-correlation algorithms to quantify bead displacements.

B.5. Cell-Outline-Based Algorithms for Calculating Contractility
As an alternative to Fourier Transform Traction Cytometry, Boundary-element-based 

qTFM methods discretize the cell rather than the substrate to calculate traction forces, which 
requires accurate determination of cell boundaries (4,5). Identification of cell boundary requires 
a separate image focused on the cell (typically 5-10 µm above the fiducial markers) and can be 
acquired in phase-contrast or fluorescence. While cell outline algorithms can reduce noise 
associated with peripheral beads, manual outlining of cells introduces additional variability and 
increases time-demand, so these algorithms are not recommended for beginners. If using 
algorithms that require cell outlines, we recommend systematizing identification of cell 
boundaries to reduce variability, e.g. using fluorescence microscopy (6) or high-resolution phase-
contrast microscopy (7).

B.6. Calculating Strain Energy
The total strain energy, W, i.e. work transferred from the cell into the substrate to 

induce deformations, can be calculated as 

𝑊 =∑1
2𝐹𝑥

2 (S1)

where W = strain energy (units: Joules, J), F = force (units: Newtons, N), and x = displacement 
(units: m). When using ImageJ plugins PIV and FTTC, the data required for this calculation are 
stored in two files. The “PIV…” file has relevant displacements (in pixels) and the “Traction…” 
file has relevant stresses that can be converted to forces.
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